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How to Migrate Access Reports to Reporting Services

Introduction

Microsoft SQL Server Reporting Services is a new reporting platform that has even more functionality and flexibility than Microsoft Access and Crystal developers have become accustomed to. In addition, it combines the speed, scalability, and manageability of centrally managed reporting, as reporting has moved from the client model to the client-server model. This brings all the advantages of Web-based applications.

This paper details how to use the Reporting Services Import Reports feature to convert reports from Access to Reporting Services and resolve any resulting issues.

While this paper focuses on the Access developer, many of the concepts are similar for Crystal Reports developers.
For further technical information, report samples and information on obtaining Microsoft Reporting Services, please see Microsoft’s SQL Server: SQL Server Reporting Services Home at http://www.microsoft.com/sql/reporting.
Important Notes

This paper does not address all the possible issues you may encounter during Access report migration. As more issues are encountered, they will be added to the updated version of this paper, which can be found on the SSW website at http://www.ssw.com.au/ssw/Standards/DeveloperSQLReportingServices/
Reporting Services does not require you to migrate your data from Access to SQL Server. However, migration of your data to SQL Server is recommended as SQL Server is a more robust, flexible and scalable data solution than Access. Reporting Services reports can use a variety of data sources, including ODBC and OLE DB compliant databases.

Examples and notes in this paper assume that reporting data is stored in Access.
This paper has been tested with Microsoft Visual Studio .NET 2003 and Microsoft Visual Studio 2005.
About SSW and the Authors

This whitepaper is written by Adam Cogan (Chief Architect) and Jatin Valabjee (Senior Software Developer) of Superior Software for Windows (SSW). SSW is a Sydney based consulting company specializing in .NET solutions for progressive businesses since 1990. SSW offers custom software solutions in ASP.NET, VB.NET, C#, SQL Server, Exchange Server, Microsoft Access and Office 2003. Adam can be contacted at adamcogan@ssw.com.au.
Adam Cogan is one of two Australian Microsoft Regional Directors and has been developing custom solutions for businesses across a range of industries such as Government, banking, insurance and manufacturing since 1990 for clients such as Microsoft, Quicken, and the Fisheries Research and Development Corporation.

Jatin Valabjee has extensive industrial experience developing Microsoft solutions. He has an in-depth knowledge of the Microsoft suite of products, including Access, SQL Server 2000 and .NET Windows Forms and Web Forms.

Information in this whitepaper is based on our experiences and observations developing Windows software and databases. We welcome any feedback to info@ssw.com.au.
How to use the Import Reports feature to convert reports from Access to Reporting Services and Resolve Problems

In most cases, migration of Access reports to Reporting Services reports is as straightforward as a single-click import process. However, once imported, you may encounter some migration issues. This section details these issues and methods to resolve them.

The process of migration involves three steps:

3. Using the Reporting Services Import Reports feature on the Access database

4. Resolving any migration issues which are listed in the Task List
5. Taking advantage of the management features of Reporting Services, such as security and performance (caching)

Throughout this paper, samples based on the Northwind Access database are used to demonstrate the report migration process. The Northwind database is shipped with Access and can be found in the Samples subdirectory of the Access installation directory. Alternatively it can be downloaded from Microsoft’s Download Center at http://www.microsoft.com/downloads/. To demonstrate new features in Reporting Services, the AdventureWorks SQL Server Database is used. The AdventureWorks database ships with Reporting Services.

Prerequisites

· The Access Database (.mdb) or Access Project (.adp)

· Microsoft Access 2002 or later

· Microsoft SQL Reporting Services

· Microsoft SQL Server 2000

· Microsoft Visual Studio with Reporting Services client tools installed
Migrating from Earlier Access Database Files – OK if Access 2002+ installed
Reporting Services can import reports from databases created with versions of Access earlier than 2002, however to allow access to the Import Reports feature in Visual Studio, Access 2002 or greater must be installed. When importing, Reporting Services may prompt to convert the database to a later version. These warnings can be ignored, but it is advisable to upgrade the database to the newer format.
Follow this procedure to upgrade an earlier Access database before importing:

6. Ensure no copies of the database are open

7. Load Access 2002 or later

8. Open the file by selecting File->Open and browsing for the database.

9. Convert and save the database under a new name by clicking Tools->Database Utility->Convert Database->To Access 2002 File Format… and save the database with a new name.

10. The reports from the new database can now be imported into Reporting Services.

Scenario

This section steps through the process of importing and resolving migration issues encountered with the following reports:

11. Invoice (a standard report)

12. Catalog and Catalog Subreport (a report with a linked subreport that displays images stored in database)

13. Employee Sales by Country (a report with conditional formatting and parameters)

14. Sales by Category and Sales by Category Subreport (a report with chart)

The First Steps for Migration

15. Create a new Report Project in Visual Studio (see Figure 1).
Figure 1 – Creating a new Report Project
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16. Use the Import Reports feature to import the Access database reports into Reporting Services (see Figure 2). Note that Reporting Services will open the database in Access during the import process. To use this feature right click on the Reports folder within the solution and select Import Reports. 

When you import the reports, Access will open while the report import is taking place. The new window will close when the process is completed.
Unfortunately there is no option to selectively import reports – they are all automatically imported. Our suggestions for improvements to Reporting Services are beyond the scope of this document but for a complete wish list please see SSW’s Microsoft SQL Reporting Services Suggestions at http://www.ssw.com.au/ssw/Standards/BetterSoftwareSuggestions/ReportingServices.aspx
Figure 2 – Importing Reports from Access
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17. View the Task List to see any errors and warnings that occurred during the import process (see Figure 3). In this exercise you will only be working with 4 of the reports. Therefore, remove the warnings for unwanted reports using the steps below.
Figure 3 – You will have some Build Errors from the import of Northwind. Despite the name, they are only warnings and the reports can still be viewed and deployed
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 icon depicts a build warning, that is, an error that occurred while attempting to import certain report elements from Access. Typically many of these items will only affect the layout or formatting of the report rather than the functionality.
Task List Management is different
Visual Studio developers would be used to seeing a task list item, clicking on it to take you to the appropriate place in the code, addressing the issue, and then seeing task list item disappear.

Unfortunately, this is not how it works in Reporting Services. You will need to manually maintain this list; it is not as interactive as you may be used to. So you need to be careful in the way you delete the reports and manage task list items (see the steps below). 

You also cannot rely on the task list to do further filtering such as filtering for the current file. Also, double clicking the task list does not open the related report.
Unfortunately, items in the task list will persist even after the report is deleted. Take care to delete reports one at a time, so that you can keep in control of your build warnings. The process for this is detailed below:

18. Note the build errors related to the report you want to delete

19. Check all the build errors related to that report (using the tick box next to the task description)
20. Delete the report

21. Repeat these steps for all unused reports

22. Hide all the Checked tasks using the Show Tasks context menu shown in Figure 4
Figure 4 – Filtering the task list to only show the relevant warnings
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When your Reporting Services project is restarted, items in the task list will disappear. It is recommended that you copy the task list contents to a Word document so that you can refer to it later as shown in Figure 5.
Figure 5 – Right click on the task list and click Copy, then paste into a Word document to preserve the warnings. [image: image7.png]



23. Delete the unnecessary project reports as shown in Figure 6.
Figure 6 – The highlighted reports are the ones you want to delete in this scenario. Due to the problem with build warnings, you should delete them one-by-one.
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Create a Shared Data Source

When a report is imported from Access into Reporting Services, the data source for each of the reports is set to point to the original Access database. This information is stored inside each report.

Clearly, this quickly becomes an issue when you have multiple reports – if the database name changes, for example, you have to go through and update the data source for each of the reports.
Reporting Services has a feature called a shared data source item, which defines a connection to a common data source. You can easily change the data source for all the reports that point to this data source, simply by changing the properties of the shared data source.

To create a data source and set all reports to use this source, follow these steps.
24. Select the project in Solution Explorer, and add a new Data Source [image: image9.png]


 to the project as shown in Figure 7.
Figure 7 – Add a Shared Data Source to your report solution
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25. Enter (local) in the server name box (or the location of your SQL Server database)
26. Select NorthwindSQL (or the name of your database) from the list of databases (as shown in Figure 8). Press OK to create the shared data source.
Figure 8 – Specify the location of the Northwind database for the shared data source
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Now you can point all reports in your solution to point to this data source.
27. Open the first report in the Solution Explorer list and click the Data tab [image: image12.png]Data





28. Click the ellipsis button [image: image13.bmp] next to the dataset dropdown list to edit the source of data for the report

29. In the Dataset window, select the shared data source (with suffix (shared)) from the Data source drop down list (as shown in Figure 9). Click OK to save changes.
Figure 9 – Set your report to use the shared data source
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30. Repeat steps 4-7 for each report.

The Steps to Successfully Migrate the Invoice Report

Step 1: Re-create the Invoices Query as a SQL Server View
If you try to preview the Invoice report now, you will receive an error because the Invoices query does not exist in your SQL Server database. Because your report is now using your SQL Server database as a data source, the Access Invoices query needs to be recreated as a SQL Server view.

31. Create a new view in SQL Server Enterprise Manager by right-clicking the Views node under your database (in this example, (LOCAL) –> NorthwindSQL –> Views) and clicking New View….

32. Enter the following query into the SQL section of the view designer (as shown in Figure 10):

	SELECT

O.ShipName, O.ShipAddress, O.ShipCity, O.ShipRegion, O.ShipPostalCode, O.ShipCountry, O.CustomerID, C.CompanyName AS Customers_CompanyName, C.Address, C.City, C.Region, C.PostalCode, C.Country, E.FirstName + ' ' + E.LastName AS Salesperson, O.OrderID, O.OrderDate, O.RequiredDate, O.ShippedDate, S.CompanyName AS Shippers_CompanyName, OD.ProductID, P.ProductName, OD.UnitPrice, OD.Quantity, OD.Discount, CONVERT(money, (OD.UnitPrice * OD.Quantity) * (1 - OD.Discount) / 100) * 100 AS ExtendedPrice, O.Freight

FROM         

dbo.Shippers S INNER JOIN

      dbo.Products P INNER JOIN

      dbo.Employees E INNER JOIN

      dbo.Customers C INNER JOIN

      dbo.Orders O ON

C.CustomerID = O.CustomerID ON

E.EmployeeID = O.EmployeeID INNER JOIN

dbo.[Order Details] OD ON

O.OrderID = OD.OrderID ON

P.ProductID = OD.ProductID ON 

      S.ShipperID = O.ShipVia




This T-SQL code selects the same data as the Invoices query in Northwind; however there are some differences in syntax and functions (such as CCur).

Figure 10 – Enter the Invoices query into the new view designer in Enterprise Manager
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33. Save the view and name it Invoices
34. Go back to Visual Studio and click the Preview tab. Your report now works, however it is retrieving all 830 reports (as shown in Figure 11). Clearly this can cause performance problems when retrieving data across a network from SQL Server.

Figure 11 – The invoice report with 830 pages is incorrect and needs to be changed to use Report Parameters.
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Access developers typically do not parameterize reports so that they can use an external filter (code outside the report) to refine the report data at runtime. For example:
DoCmd.OpenReport "Invoice", acViewNormal, , "OrderID = " & [ctlOrderID]

Step 2: Other Issue 1 - Adding Report Parameters
You now must add a parameter to the Invoice report so that the user must explicitly specify an Order ID so that only one report is selected at a time.
35. Open the Invoice report in your report project in Visual Studio and select the Data [image: image17.png]Data



 tab

36. Add a SQL WHERE clause to your report query. In the SQL window, enter the following query.

SELECT     *

FROM         Invoices

WHERE     (OrderID = @pOrderID)

When you add the WHERE clause to your query, Reporting Services automatically creates a report parameter (which can be accessed from Report–>Report Parameters).

37. Click the Preview tab to preview your report (you may need to click the Refresh button). Enter a valid OrderID, (one valid Northwind OrderID you can use is 10643) and click View Report.
38. If you want to change the text shown for the Order ID prompt (currently the name of the parameter, pOrderID), go to Layout mode and click Report->Report Parameters. Change the Prompt name to Order ID, as shown in Figure 12.

Figure 12 – Change the prompt text of your report parameter
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Step 2b: Visual Studio 2005: Add a multi-valued parameter
[image: image19.png]P Visual Studio 2005




Visual Studio 2005: New feature! You can now have multi-valued parameter lists, meaning you can select more than one record to display.
39. Create a new DataSet from the Data tab in the Invoice report. Call it OrderIDs.
Figure 13 – Create a new DataSet that contains a list of all Order IDs
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40. Go the Report parameters (Report->Report Parameters)
41. Select the existing pOrderID parameter and tick Multi-value
42. From Available Values, select From query and select the 3 fields from the OrderIDs dataset you created (see Figure 14). Press OK to close.

Figure 14 - Modify the report parameter to be multi-valued
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You now need to modify your query to accept multiple values. Reporting Services treats multiple selected values as a comma-separated list, so you need to use a SQL IN clause to allow for this.
43. Return to the Data tab and change the query for DataSet1 to the following.

SELECT
ShipName, ShipAddress, ShipCity, ShipRegion, ShipPostalCode, ShipCountry, CustomerID, Customers_CompanyName, Address, City, Region, 

PostalCode, Country, Salesperson, OrderID, OrderDate, RequiredDate, ShippedDate, Shippers_CompanyName, ProductID, ProductName, UnitPrice, Quantity, Discount, ExtendedPrice, Freight

FROM         Invoices

WHERE     (OrderID IN (@pOrderID))
44. Preview the report. You will get the following error:
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This is happening because when you create a second DataSet for the report, the DataSet for the main list control in the report gets reset.

45. Re-select DataSet1 for the GroupLevel0 List control (see Figure 15 and Figure 16).

Figure 15 - Select the GroupLevel0 List control...
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Figure 16 - ... and reselect the DataSet
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46. Preview the report. Now you can select multiple Order IDs and click View Report to show only those reports. Very handy!
The Steps to Successfully Migrate the Catalog and Catalog Subreport Reports
Step 1: Re-create the Catalog Query as a SQL Server View

Queries are not converted to SQL Server when upsizing, so they must be recreated. Follow these steps to recreate the Northwind Catalog query as a view.

47. Create a new view in SQL Server Enterprise Manager

48. Paste the following code into the SQL designer. It performs the same data selection as the Catalog query in Access Northwind.
	SELECT

dbo.Categories.CategoryName, dbo.Categories.Description, dbo.Categories.Picture, dbo.Products.ProductID, dbo.Products.ProductName,                       dbo.Products.QuantityPerUnit, dbo.Products.UnitPrice

FROM

dbo.Categories

INNER JOIN

dbo.Products ON dbo.Categories.CategoryID = dbo.Products.CategoryID

WHERE     (dbo.Products.Discontinued = 0)


Notice the differences in syntax and data types between Jet SQL (Access) and T-SQL (SQL Server), such as Yes/No data type being replaced by a bit (0 i.e. false).
49. Save the view as Catalog
Step 2: Task List Item 1 – Forced Page Breaks

The first is an issue concerning the report layout, control grouping, and pagination controls within the Access report. These are typical problems concerning report migration. This problem is caused by a forced page break within the header of the report. When this is converted to Reporting Services, the entire header is placed into a single rectangle and this break is lost (as shown in Figure 17). To recreate breaks, follow these steps.
Figure 17 – The forced break within the Access header section is lost in the conversion
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Related items can be grouped using the rectangle control [image: image26.png]{1 Rectangle



.

50. Drag a new rectangle control onto the report layout
51. Drag and drop all the contents that are to be on a separate page into the newly created rectangle

52. Set the properties of the rectangle to allow page breaks before and after for proper pagination as shown in Figure 18.
Figure 18 – Check both boxes for the Page Break properties for a Rectangle control
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53. Check the task list item as complete. There should still be one remaining item for this report.

Step 3: Task List Item 2 – Database Images

The second issue is because the Access report makes use of a bound object control to display pictures that are stored in the database (as shown in Figure 19).
Figure 19 – An Access bound object frame for database images does not get imported
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The same can be done with Reporting Services when reading from an Access database; however the source for the image needs to be corrected in order to remove some of the information added by the Jet / OLE data source driver for Access databases.

To create the new image control:

54. Drag an Image [image: image29.png]


 onto the report next to the Catalog item description box
55. In the image creation wizard, select the image source as a Database type and select the Picture from the dataset that contains the image data.
Figure 20 – Add a new Image control to the page and use the <Expression…> field to set the value.
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56. Replace the default value in the image’s Value field with the following expression as shown in Figure 20. 

=System.Convert.FromBase64String(Mid(System.Convert.ToBase64String(Fields!Picture.Value),105))

where Picture is the database field with the stored image data.

57. Check the task list item as complete. There should be no more tasks remaining for this report.

Step 4: Other Issue 1 – Breaks Before Categories

In Access, there is a page break before the start of each category in the catalogue. These are not imported into Reporting Services and so have to be recreated. This is quite a straightforward process:

58. Select the rectangle named GroupHeader0 that contains the category header

59. Set the PageBreakAtStart property to True (as shown in )
Figure 21 – Set a page break before each category…
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Figure 22 – …so that each category appears on a new page in the report
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The Steps to Successfully Migrate the Employee Sales by Country Report
Now the issues associated with the migration of the Employee Sales by Country report are addressed. The following build warnings were raised during the import so these are handled first.
Employee Sales by Country: Modules are not supported.

Employee Sales by Country: The object Employee_x0020_Sales_x0020_by_x0020_Country is associated with the ON-NO-DATA event. Events are not supported.

 Employee Sales by Country: The object GroupHeader0 is associated with the ON-FORMAT event. Events are not supported.

 Employee Sales by Country: The object GroupHeader2 is associated with the ON-FORMAT event. Events are not supported.

Employee Sales by Country: The object GroupHeader2 is associated with the ON-FORMAT event. Events are not supported.

Step 1: Recreate the Employee Sales by Country Query as a View

When you upsize your Access MDB, your queries do not get migrated into SQL Server. For the Employee Sales By Country report to work correctly, you need to manually recreate the query as a view in SQL Server. Once created, you must use this view as the record source for the report and add parameters to the report query. Follow these steps to recreate the Employee Sales By Country query as a view, and use it in the report.

60. Create a new view in Enterprise Manager 

61. Paste the following SQL into the SQL window:

	SELECT OrderID, SUM(CONVERT(money, (UnitPrice * Quantity) * (1 - Discount) / 100) * 100) AS Subtotal

FROM dbo.[Order Details]

GROUP BY OrderID


62. Save the view as Order Subtotals
63. Create the Employee Sales By Country Access query as a view in SQL Server. Create a new view and insert the following SQL:
	SELECT DISTINCT Employees.Country, Employees.LastName, Employees.FirstName, Orders.ShippedDate, Orders.OrderID, [Order Subtotals].Subtotal AS SaleAmount

FROM Employees INNER JOIN (Orders INNER JOIN [Order Subtotals] ON Orders.OrderID = [Order Subtotals].OrderID) ON Employees.EmployeeID = Orders.EmployeeID


64. Save the view as Employee Sales By Country (rename any stored procs with the same name)
In the original Access query there were two parameters for sales start date and sales end date. These now need to be created in Reporting Services.

65. Open the Employee Sales By Country report in Reporting Services and select the Data tab

66. Change the query to include a WHERE clause. Use the following query:
	SELECT     *

FROM         [Employee Sales By Country]
WHERE     (ShippedDate BETWEEN @Beginning_Date AND @Ending_Date)


The 2 parameters are automatically created for you and linked to the report.
67. Set both report parameters to be type DateTime and uncheck Allow null value.

68. Go to the Preview tab to test the report. Enter 1/1/1996 as the start date and 12/12/1996 as the end date and click View Report.

Step 2: Task List Item 1 – Conditional Formatting

The first Task List item refers to the conditional formatting code in Access used in this report to display the Exceeded Goal! red label if the employee being viewed exceeded their sales target. In Access report designer, this code is found in the Format event for the group header containing the label (see Figure 23). In later versions of Access, conditional formatting can be placed into the control itself (as shown in Figure 24).
Figure 23 – In Access for conditional formatting you can write some code in the Format event
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Figure 24 – Northwind does not do it this way but the conditional formatting code would look like this
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As previously mentioned, Reporting Services does not support events and thus will not import this event. To apply conditional formatting to report items in Reporting Services, expressions are used for any number of the style properties that need to be controlled. Expressions can be used to dynamically control the values for many properties; for example, to set the visibility of the Exceeded Goal! label based upon the total amount of sales (see 
Figure 25
 and Figure 26). Use the following expression to set the Exceeded Goal! label’s visibility:
=iif(Sum(Fields!SaleAmount.Value) > 15000, False, True)
Figure 25 – Add an <Expression…> to the Hidden property of the Exceeded Goal! textbox to simulate Access’ conditional formatting…
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Figure 26 – … Set the expression for the ExceededGoalLabel to toggle visibility with this expression
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Note that the hidden property is being set so that the control is not hidden if the amount is greater than 15000.

Check the task list item as complete. There should still be 3 remaining items for this report.

Step 3: Task List Item 2 – Modules Not Supported

This Task List Item refers to the fact that Reporting Services does not support custom Access modules, that is, code behind an Access report. This code must be added manually as expressions in Reporting Services. The other task list items all are related to this one and should resolve this issue, so this will be addressed later.

Step 4: Task List Item 3 – No Data

When the data source returns no data in an Access Report, a custom event can be used to control the content that is displayed, or to perform some other function. This is achieved by using the report NoData event (see Figure 27 and Figure 28). Reporting Services has a similar functionality; however this can apply to any data region type (list, table, matrix, etc.) via the NoRows property. A message can be used in place of the control’s content or an expression can be written to carry out some other event.
Figure 27 – The Access NoData event
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Figure 28 – The Access code for the NoData event
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In the NoRows property for the main Detail list, set the expression to display the string “No Data for Date Range” (see Figure 31).
Figure 29 – Select the Detail List in the report to specify what to display when there are no rows
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Figure 30 – The Reporting Services NoRows property for a data region type control provides equivalent functionality
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Figure 31 – Add the message to the <Expression...> for the No Rows property of the list control.
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Check the task list item as complete. There should still be two remaining items for this report.

Step 5: Task List Item 4 – Events Not Supported

This is the same warning produced by Task List Item 1. It simply refers to the fact that custom code behind Access reports is not supported in Reporting Services. Again, any code can be moved to an expression for the report item. In this case, the code restarts the page numbering at the beginning of each new group as shown in Figure 32. Unfortunately there currently is no support for this type of action in Reporting Services.
Figure 32 – The Access code that caused the Reporting Services event warning. This code is used to reset the page counter each time the group restarts. This functionality cannot be added in Reporting Services
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Check the task list item as complete (as this cannot be resolved). There should still be one remaining item for this report.

Task List Item 2 (Revisited) – Modules Not Supported

Having reviewed all of the functions for the code module of the report throughout the course of resolving the other task list items, the task list item can be checked as complete. There should be no more remaining items for this report.

Other Issue 1 – Parameters

The Employee Sales by Country report requires two parameters – start date and end date. These were imported during the process but on closer inspection of the properties of them you will notice that they have not so friendly names, and also are of string type. To correct these issues open the Report Parameters dialog (Reports->Report Parameters…) and correct these issues as shown in Figure 33.
Figure 33 – Change the parameters to use DateTime data type and give them more user-friendly names
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The Steps to Successfully Migrate the Sales by Category Report

Now the issues associated with the migration of the Sales by Category report will be addressed. The following build warnings were raised during the import so these are handled first.

Sales by Category: The control SalesChart is an unsupported type.

Step 1: Task List Item 1 – Charts

Charts created in Access are not imported into Reporting Services. They must be recreated manually using the Reporting Services chart tool, however it is a relatively straightforward process. The following process shows how to convert the bar chart in the Sales by Category report (see Figure 34) to Reporting Services.
Figure 34 – A section of the Sales by Category report showing the chart in the Access report
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69. Open the report in Reporting Services and select Layout mode [image: image45.png]W« Lavout



. Select the chart tool [image: image46.bmp] from the toolbox, and click and drag a box of a reasonable size on the report layout to create a chart as shown in Figure 35.
Figure 35 – Drag on the Chart control in the Report Designer, add the fields
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70. The data to display on the chart now needs to be set. Click the Fields [image: image48.bmp] tab button at the bottom left of the screen to display the available data fields. Double-click the chart to display the chart field placeholders.

71. Set the data fields, that is, the fields that comprise the values in the chart and are represented by the bars. Drag and drop the ProductSales field into the Drop data fields here box. Then drag the ProductName field into the Drop category fields here box to set the grouping of the chart; in this case, the product sales are grouped by product name.

72. Set the properties of the chart to match the chart in the Northwind report. Right-click the chart and select Properties. Set the chart type to Bar, then select the Legend tab and uncheck Show Legend. Press OK to confirm changes. Click the Preview tab [image: image49.png]Preview




to preview the report as shown in Figure 36.
Figure 36 – Check that the Preview of the chart looks correct
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73. Notice that the chart is sorted in reverse alphabetical order, whereas the chart in the original Northwind report is sorted alphabetically. Set sorting properties for the chart by right-clicking the chart, and selecting Properties.

74. Select the Data tab, select the first item in the Category Group list box (the default name is chart1_CategoryGroup1) and click Edit…. Click the Sorting tab, choose =Fields!ProductName.Value in the first row under the Expression heading, and select Descending under the Direction heading (see Figure 37).
Figure 37 – Setting the sort order for the bar chart
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Step 2: Other Issue 1 – Linked Subreports

When you enter Preview mode for the Sales by Category report, you will notice that the subreports do not appear correctly; all products appear under every category. The link between the main report and the Sales by Category Subreport has not been preserved correctly – the subreport needs to have its parameters linked to the main report. Follow these steps to link the main report and subreport.
75. Open the Sales by Category Subreport
76. Click the Data tab

77. Modify the SQL query to include a WHERE clause:

	SELECT     *

FROM         [Sales by Category]

WHERE     (CategoryID = @pCategoryID)


This will allow the main report to pass a CategoryID so that the subreport will filter based on it. You now need to link the main report to the subreport.

78. Open the Sales by Category report

79. Click the Layout tab

80. Right-click the subreport in the layout and select Properties
81. Select the Parameters tab. This is where you do the same thing as Link Master and Link Child in Access.

82. Match up the main report and subreport parameters as shown in Figure 38
Figure 38 - Link the main report and subreport via the report parameters
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Deploy the Reports

The reports have now been successfully imported to Reporting Services and can now be deployed to the reporting server (see Figure 39). Ensure that the report has been set to deploy to the correct reporting server by selecting the report project in Solution Explorer, selecting the Project menu, and choosing Properties.
Figure 39 – Deploy the Report Project
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The reports are now successfully deployed and other users can now view these reports in their browser.

For more information on report deployment in Reporting Services, see Microsoft’s Reporting Services page at http://msdn.microsoft.com/library/default.asp?url=/library/en-us/RSPORTAL/HTM/rs_gts_portal_3vqd.asp. Also see the Hot Tips and Tricks section on suggestions for optimizing and fine-tuning reports.

Give Users Easy Access to Your Reports

All Reporting Services reports are stored in one location on the Reporting Server. The URL to the reports is usually in the format http://servername/reports. To facilitate easy access to the reports for users, add a hyperlink to the reports page from your forms.

Conclusion

Microsoft® SQL Server™ Reporting Services is a powerful reporting solution that provides centralized management, an open architecture for robust extensibility, and seamless integration into existing business environments.

Migration of existing reports from Microsoft Access to Reporting Services is often as straightforward as a quick import process. Once imported, expect some compatibility issues, and use some of the above techniques to resolve them.

Hot Tips and Tricks

It is highly recommended that you read and implement the following tips to ensure a manageable and efficient Reporting Services solution.

Tip 1 – Run Regular Expressions to Ensure Your Reports Follow Company Rules

Because RDL files are simply plain text files, code sniffing tools can be run to ensure reports follow your company standards. For example, to ensure all reports are using a shared data source and do not have the connection string behind the report, you could run a regular expression like this:

<ConnectString>.*</ConnectString>

You can write some code in .NET using System.Text.RegularExpression, or you can use third-party tools; for example:
· UltraEdit (www.ultraedit.com)

· SSW Code Auditor (www.ssw.com.au/CodeAuditor) (see example below)

SSW Code Auditor provides a graphical wizard-style interface to make the task of building regular expressions easier. It analyzes your RDL files against a set of rules, and produces a report (as shown in Figure 40) which can then be used to correct any errors found.

Figure 40 – As RDL files are in text, tools such as SSW Code Auditor can show reports on files that break specified rules – leading to better quality control
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Table 1 lists some regular expressions you can use to verify the correctness of your reports.
Table 1 - Regular Expressions to use on your RDL files
	Rule
	Regular Expression

	A connection string was found in the report. All data connection information should be removed from every report and moved to a Shared Data Source Item in the Report Project (see the Create a Shared Data Source section)
	<ConnectString>.*</ConnectString>

	The SQL query used for the report data should not contain “SELECT *”, because it is an inefficient method of selecting data. Only the fields required for the report should be retrieved, e.g. “SELECT ID, FirstName, LastName, PhoneNumber”
	(?i:SELECT) \*

	Build warnings should not exist in the report. These warnings are typically caused when importing unsupported report items from Access into Reporting Services, and appear as XML comments in the RDL file.
	<!-- (?i:Warning).*-->


Tip 2 – Organize Images

Reporting Services offers three options for storing images on the server: embed the image as a MIME type into the report directly, store the image on the server and link it from the report, or get the image from a database. Typically within a Report Project the images should be placed in a sub folder of the main project. This way, all reports can make use of the same images, so that if any image is changed then no changes to any of the reports are required. The same should be done within a Reporting Services report.

There are two options for doing this. The first is to use Report Manager to manually create a new Images subdirectory of the deployed project and upload each image into this directory. The problem with this method is that the images are no longer directly associated with the reporting project. The second is to use Visual Studio to handle the deployment of images when deploying reports. Subdirectories cannot be used in the Reporting Services project, so a separate Visual Studio Report Project must be created which contains all images as resources. When this project is added to the main Report Project, the images contained are deployed when the reports are deployed.

Tip 3 – Stop Deployment of the Reports
Typically a Reporting Services project will be only one part of an application’s solution file. Once development has been finished on the reporting component of the solution, auto-deployment should be deactivated to save time when rebuilding the solution. Follow this procedure in Visual Studio:

83. Open the properties dialog of the solution

84. Select Configuration Properties

85. Uncheck the Deploy checkbox for the reporting project as shown in Figure 41.

Figure 41 – You can turn off Deploy in Solution compilation options to speed up compilation time – useful when you are working with aspx pages
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Glossary – New Terms for Access Developers

	.NET

A Microsoft set of technologies with the goal of providing individual and business users with a seamlessly interoperable and Web-enabled interface for applications and computing devices, and to make computing activities increasingly Web browser-oriented
.

	Conditional Formatting

Setting formatting of a report element (text label, image size) based on a certain condition. For example, show a price in red if the value is over $500.

	Expression
Used by Reporting Services to retrieve data from database fields and to define conditions and perform calculations. Also used to invoke external business logic.

	IIS
Internet Information Services. The Web server package installed with Microsoft operating systems.

	Linked Subreports
Subreports that have their content filtered based on some bound field in the master report

	Microsoft SQL Server Reporting Services

A Microsoft reporting solution which provides a complete set of tools and applications that can be used to author, publish, and manage reports
.

	RDL
Reporting Services Report Definition Language. An XML structure used by Reporting Services which encompasses all possible variations that a report can assume. At a minimum it specifies a query and other report content, report properties, and report layout.

	Report Designer

Report Designer is a tool used to publish reports to a report server. Report Designer is integrated with Microsoft Visual Studio® .NET 2003.

	Report Manager

Report Manager is a Web-based report access and management tool that is included with Microsoft® SQL Server™ Reporting Services. It is used for the management of reports, resources and the report server.

	Shared Data Source

Used by Reporting Services to define reusable database connection information which can be accessed by multiple reports.

	Subreport
In Reporting Services, a subreport is an item embedded in a report that points to another report. The child report may run as part of the full report or itself can be a full report.

	XML
eXtensible Markup Language. A widely adopted standard way of representing text and data in a format that can be processed without much human or machine intelligence.


For more information:

http://www.microsoft.com/sql/!href(http://www.microsoft.com/sql/)
Did this paper help you? Please give us your feedback. On a scale of 1 (poor) to 5 (excellent), how would you rate this paper?!href(mailto: sqlfback@microsoft.com?subject=Feedback: [How to Migrate Access Reports to Reporting Services])
� searchwebservices.techtarget.com, “A searchwebservices definition”


� Microsoft Reporting Services Books Online, “Introducing Reporting Services”





